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What Is Genetics Construction Kit?
Genetics Construction Kit (GCK) is a simulation of a classical genetics laboratory. It
provides you with a set of organisms with unknown patterns of inheritance, and
gives you the tools to design and perform an experimental strategy to discover these
inheritance patterns. You will be able to cross the unknown organisms and analyze
your crosses in ways much like those used by practicing scientists. GCK is not meant
to replace work with real organisms. But the constraints of time, space, money, and
unskilled laboratory technique -- important parts of real scientific research -- make it
practically impossible for most students to experience the excitement and challenge
of a real research problem. GCK can give you the chance to work with problems that
have the real surprise and real complexity that make scientific research a fascinating
activity. We have tried in this program to let you tackle realistic problems in a way
similar to that used in real scientific research. You or your instructor, however, can
set up GCK so you can start with a limited set of genetic phenomena and add new
material as your understanding grows.
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What You Should Read
If you are unfamiliar with the Macintosh computer.
Read the separate document BioQUEST: Macintosh Fundamentals
If you want to know whether or not you have the right equipment to run the
program.
Read the Appendix entitled Hardware and Software Requirements (p. 53).
If you are familiar with the Macintosh but not with this program.
Read the section entitled A Tour of Genetics Construction Kit (p. 5).
If you want to get started right away and you already have the program
running.
Read the section entitled Doing a Cross(p. 8).
If you've been through the Tour of GCK and want more details.
Read the section entitled Reference (p. 13).
If you started by skimming the manual but have found something that
doesn't seem right.
Read the section entitled A Word of Warning(p. 4) or the appendix
entitled It Doesn't Work!(p. 52), or consult the index(p.54).
If you are a veteran user of the program and want to know what is different
about this version.
Read the separate document entitled Genetics Construction Kit Version
History.

Genetics Construction Kit
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What You Need To Know
We assume that you are already familiar with the basic set of standard Macintosh
terms and operations. If you are not comfortable with these, you should read
BioQUEST: Macintosh Fundamentals or another introduction to the Macintosh
before you begin. Better yet, find someone who knows what she is doing, show her
this list of words, and ask her to explain what each of them means. The terms you
need to be familiar with are: window, menu, mouse, point, click, shift click, drag,
and double click. If you understand these, you are ready to get started. Before long,
however, you will also need to know several more Macintosh terms: close box,
zoom box, grow box, title bar, scroll bar, clipboard, and desk accessory.
We also assume that you know how to start a program. If you think you know how,
but you experience difficulty, look at the Appendix entitled It Doesn't Work! for
suggestions that we hope will help.
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A Word of Warning
It is possible that what you read in this manual may not exactly reflect what you see
on the screen as you use the program. The reason for this is that GCK is very
flexible and can be changed to adapt to local needs in many ways. Rather than
qualify every statement in the manual with warnings about what might be different
in your copy of the program, we list the possible differences here.
•

The names of traits and variations may be different. The standard
version of GCK uses a set of names that refer to fruit flies. Your
version may instead use a different set of names.

•

The number of traits used in your problem may be different. In the
example used in A Tour of Genetics Construction Kit, a monohybrid
problem is used. In some of the examples in the Reference section, a
three-trait problem is used.

•

The genetics will almost certainly be different. GCK usually starts
every new problem with a new set of inheritance patterns. This means
that the genetics of the problem you see in front of you will be different
from those in the manual example. They will always, however, be
consistent with current understanding of genetic mechanisms.

•

The menus we describe here may be different than yours. In particular,
it is possible that a menu operation that we describe may be missing in
your problem. The initial part of this manual, A Tour of Genetics
Construction Kit, describes only those operations that are least likely to
change, so we hope you won't encounter this situation.

Genetics Construction Kit

A Tour of Genetics Construction Kit
Starting the Program
To start the program, double click on the GCK program icon (see Figure 1).

Figure 1. The GCK program icon.

The next thing you see will probably be a list of problems such as that shown in
Figure 2. The names of the problems will probably be different. If you don't see a
list of problems, your copy of GCK only contains a single problem. It has started that
problem, and you can skip the next section on how to choose a problem. If you do
not see a display similar to that in Figure 2 or Figure 3, something is not working.
Try looking at the end of this manual in It Doesn't Work! for some suggestions.

5
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Choosing a Problem

Figure 2. Selecting a GCK problem.1

To choose a problem, click on it to highlight it in black (like 1 Trait, Simple
Dominance in Figure 2), then click on Start Problem.
If you click on the button labeled Quit instead of Start Problem, GCK will stop
running.

1If

you don’t see a picture of a fruit fly but have a set of buttons displayed instead, you have a
customizable copy of the program that allows you to create your own problems. For the moment, ignore
this difference and continue with the tutorial. The section of the manual entitled Designing Your Own
Problems discusses how to customize the program.

Genetics Construction Kit

Looking at the Field Population

Figure 3. The initial display of a GCK problem.

A GCK problem always starts like this (Figure 3), with a vial of organisms of
unknown genetic constitution. The initial vial is labeled Field Population to
remind you that these organisms may be considered to have been collected at
random. They are not the result of a mating between two parents.
Your problem will not look exactly like this. This particular vial contains a number
of organisms that differ in one trait, the thorax. Your problem may involve more
than one trait, a different trait, or different variations.
Grooveless and Tetraltera are the names of two thorax variations in real fruit flies.
For our purposes right now, it does not matter what a Tetraltera thorax actually
looks like.2 Bear in mind, however, that although the names used here may be the
names of the traits of a real organism, the way they are inherited will almost
certainly be different. The genetics of the organisms used by GCK vary from
problem to problem.
On the left there is a set of male and female symbols. Remember that is the
standard symbol for a male and is the standard female symbol. Each of these
symbols represents a unique individual with its own, distinct genotype.
The first two rows of organisms in Figure 3 have a Grooveless thorax and the
second two rows have a Tetraltera thorax. The arrow is shown over a male with a

2If

you are curious you might want to consult a Drosophila manual. Most commercial suppliers of fruit
flies have these.
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Grooveless thorax. If you click on a trait variation name, a dotted line will be drawn
around the organisms with that variation. Figure 4 is an example of this.

Figure 4. The dotted line shows that the first two rows of organisms are Grooveless.

Genetics Construction Kit
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Doing a Cross

Figure 5. The GCK Cross menu.

Get Some Help
In Figure 5 the Cross menu has been pulled down. You can see that the Cross
menu itself and all of the menu items are gray. A menu is gray if all of its items are
gray, and a menu item is gray if it won't do anything. A gray menu or menu item
is usually called inactive. While the entire Cross menu may not be gray in your
problem, some of the individual items on the Cross menu will be gray.
In GCK, if you try to choose an inactive menu item, you will be shown a short
message explaining why the item is inactive and how to make it active.
To try this, pull down the Cross menu and try to choose the Cross Two menu item.
When you release the button, a window like that in Figure 6 will appear. To see the
remaining text, move the mouse pointer over the downward pointing arrow and
click. To dismiss the help message, click in the window’s close box.
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Figure 6. A message explaining why Cross Two is gray.

This message tells us that we need to select two organisms of opposite sexes before
we can do a Cross Two cross.
Select the Organisms To Cross
To select the two organisms you want to cross, move the mouse pointer over an
organism, and click. That organism will be selected. A selected organism is
highlighted in black. In Figure 7, the third organism in the first row (a male) is
selected. To select a second organism, you need to hold down the shift key on your
keyboard while you click on the second organism.

Figure 7. Selecting an organism.

Choose Cross Two
After you have chosen and selected two individuals, pull down the Cross menu
and choose Cross Two. If you have selected two individuals of the same sex, or if
you don't have two individuals selected, Cross Two will be gray to indicate that it is
not possible. In this case, select two organisms of the opposite sex and try again.

Genetics Construction Kit
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Look at the Progeny
When you have crossed two individuals, a vial of progeny will be produced. This
vial will be assigned the next number in the sequence of vials and placed in the next
space on the screen. The sex and phenotype of the parents of each vial are recorded
in a space at the bottom of every vial (note that vial 1 has no parents). Figure 8
shows vial 1 and vial 2. As you can see, the phenotypes of vial 2's parents are
recorded at the bottom. The number preceding each parent is the number of the
vial the parent came from. In this case both parents came from vial 1.
The two sex symbols that you see highlighted in Figure 8 represent the same
individual, once in its home vial and once as a parent in vial 2. Clicking on either
one will highlight them both. If the same organism is a parent in more than one
vial it will be highlighted everywhere it appears. This is a convenient way to tell
exactly which individuals have been used in which crosses.

Figure 8. The results of the cross. The female parent of vial 2 has been selected.
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Look at All the Progeny
If you click in a vial’s zoom box, in the upper right-hand corner, the vial will expand
so as to display all of the organisms it contains. Figure 9 shows vial 2 after it has
been zoomed in this way. To return the vial to its former size, click in the zoom box
a second time.

Figure 9. Vial 2 zoomed so that all progeny are visible.

Summarizing the Vial
Instead of counting each of the symbols in vial 2 to find the ratio of Tetraltera to
Grooveless organisms, you can have the computer do the counting for you. Select
the vial you want to summarize (in this case, vial 2) by clicking once on the vial
title. The title will be displayed on a black background when a vial is selected. Then,
choose the Summary Chart option from the Analysis menu. A window similar to
that shown in Figure 10 will appear.

Figure 10. A vial summary for the Thorax trait.

This summary shows the ratio between Tetraltera and Grooveless, two variations of
the Thorax trait. If you want to look at the ratio between the sexes instead, click in
the box to the left of Sex to mark it, click in the box to the left of Thorax to unmark
it, and click on the Rebuild button to rebuild the Summary Chart to show the ratio
between the sexes. At least one box must always be marked, so you cannot remove
the mark on Thorax before you mark Sex. You can mark both sex and thorax and

Genetics Construction Kit
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the summary will show all 4 phenotypes (note: it's good practice to save your work
often).

Quitting
This is the end of the tour of Genetics Construction Kit. If you want to quit at this
point, you can do so by choosing the Quit item from the File menu. If you have
done any crossing, you will be asked if you want to save your work. If you decide not
to quit after all, click on the Cancel button. If you save your work, the section in the
reference section entitled Opening a Saved Problem will tell you how to restore the
problem to where you left it.
If you want to look at Genetics Construction Kit in more detail, read the Reference
section.
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Reference
Controlling Vials

Figure 11. The parts of a vial

Selecting a Vial
Before you can perform an operation on the contents of a vial or a series of vials,
you need to select it. Selection is necessary if you want, for example, to destroy
vials, summarize them, or perform a chi squared test on their population.
Note that a selected vial may or may not be the frontmost or active vial. There is
always only one frontmost window, but there may be one or many selected vials.
The easiest way to select a vial is to click once on its title. Clicking a second time will
unselect the vial. A selected vial's title is printed on a black background. An
unselected vial's title is printed on a white background. The vial shown in Figure 12
is selected.
To select more than one vial, hold down the shift key while clicking on subsequent
vials. This is useful when you want to clump the populations of several vials
together an summarize them, or to do a chi squared test.

Genetics Construction Kit
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Figure 12. A selected vial.

Changing Vial Size and Shape
Closing a Vial
When you have many vials on the screen, it is convenient to reduce some of them
to miniature form so that you can put them out of the way. If you move the mouse
pointer over the close box , in the upper left corner (see Figure 11), and click, the vial
will shrink down to icon form. Figure 13 is a picture of a vial in icon form. When
you want to re-open a vial in icon form, click twice in quick succession on the icon.
Note that it is not necessary for a vial to be open for you to select it. Select a vial in
icon form by clicking anywhere on the icon.

Figure 13. A vial in icon form.

Zooming a Vial
If you click in the zoom box, in the upper right corner (see Figure 11), the vial will
enlarge to display its entire contents. Clicking in the same place again will shrink it
back to its former size and position.
Resizing a Vial
To change the size or shape of a vial, press the mouse pointer over the grow box , in
the lower right corner (see Figure 11) and, while holding the mouse button down,
move the mouse. Move the mouse down to make the vial taller, and move it to
the right to make the vial wider. When you release the mouse button, the vial will
be redisplayed with the new size and shape. Figure 14 is a picture of a vial that has
been widened so that all of the traits are visible.
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Figure 14. A resized vial.

Scrolling Vials
Many vials hold considerably more information than they have room to display.
The three scroll bars (see Figure 15) allow you to see information that was not
originally visible. The organism scroll bar scrolls horizontally through the
organism symbols, the trait scroll bar scrolls horizontally through the traits, and the
vertical scroll bar scrolls vertically through the phenotype descriptions and
associated organism symbols.
Every scroll bar is either active or inactive. An active scroll bar has a gray
background, which indicates that there is invisible material. An inactive scroll bar
is all white, indicating that all available material is already visible. In Figure 15,
both horizontal scroll bars are active and the vertical scroll bar is inactive. This
means that that there are only two phenotype classes in this vial. If there were more
than two, the vertical scroll bar would be active. Similarly, there is at least one trait
other than Wing Shape. To see what it is, we can click once in the trait scroll bar's
right arrow. The result is illustrated in Figure 16.

Figure 15. Both horizontal scroll bars are active; the vertical is inactive.

Genetics Construction Kit
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Figure 16. The trait scroll bar has been scrolled to the right once.

Notice that the white box (the scroll box) in the trait scroll bar now appears in the
center of the scroll bar. This indicates that there is additional information both to
the right and to the left of the Eye Color trait. There are at least three traits in this
problem.
Adjusting the Window Pane
Vials are divided into two window panes. The left-hand pane holds the organism
sex symbols, and the right-hand pane holds phenotype descriptions. You can change
the allocation of space between the two panes by clicking in the black rectangle at
the base of the line separating the two panes (the pane control) and dragging it to
the right or left.
Figure 17 shows the same vial as in Figure 14 but the pane control has been dragged
to the right so that all the organism symbols are visible. The mouse pointer is over
the pane control.

Figure 17. A vial with the window pane line moved to the right.
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Reorganizing a Vial
Changing Trait Order
To change the trait display order, click on the name of the trait and drag it to the
position you want. I clicked on the word “Bristles” in Figure 17 and dragged to the
right to move it off the end, making space for the Eye Color trait. The resulting vial
is shown in Figure 18. Changing the trait display order in one vial also changes it
anywhere a list of trait names is displayed.
Changing the trait display order is particularly useful when you want to concentrate
on one trait and ignore the others. In this situation, drag the trait of interest all the
way to the left and resize the vial so that you can see only that trait.
Notice that as you drag a trait column, the phenotype descriptions automatically
scroll so that you can drag a trait to a part of the phenotype description that was
initially invisible.

Figure 18. The Bristles trait has been moved off to the right to make room for Eye Color.

Changing Row Order
Just as you can rearrange the horizontal order in which traits are displayed, you can
rearrange the vertical order of the phenotype classes. This allows you to cluster
organisms with interesting phenotypes near the top of the vial.
To drag a vial row, click somewhere over the phenotype description part of the row
(in this example, over one of the words “Wavy,” “Ruby,” or “Clot”), and drag up or
down.
Figure 19 shows the same vial as Figure 18, but with the order of the two phenotypes
reversed.

Genetics Construction Kit
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Figure 19. The order of the two phenotype classes is reversed.

Reading the Parental Information
Information about the breeding pair that produced a vial is displayed at the bottom
of the vial. The initial number is the number of the vial that contains the parent.
In Figure 19, both parents are from vial 1.
If you click on a parent's symbol, the parent will be highlighted not only where you
have clicked, but also in its home vial. This allows you to identify which particular
individual was used in the cross. It is also useful when you want to do another
cross using the same parent: select it here and do the cross.

Opening a Notepad
Clicking on the notepad icon ( , upper left corner of every vial) will open a window
which can be used for taking notes. You can type into this notepad, paste pictures
from other GCK windows into it, print it, or copy it out into a word processor to
help when you prepare your lab report.
When you have written into a notepad, the icon changes to indicate that the
notepad is no longer blank ( ).
For more information about using notepads, see the sections below entitled Taking
Notes and Communicating with Other Programs.

Destroying a Vial
To destroy a set of vials, select them and then choose Destroy Vials from the
Utilities menu. If you destroy a vial, it cannot be recovered.
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Since destroying a vial is a somewhat dangerous action, you will be asked to confirm
if this is really what you want to do. The original vial (the field population) cannot
be destroyed.
There are really only two reasons to destroy a vial. If you have reason to believe
that you are running out of computer memory, destroying vials will give you more
space. Or you may find that the computer display is becoming too cluttered, and
that destroying a few uninteresting vials will make it easier to find things.

Selecting Organisms
In order to do anything with an organism, such as breed it with another organism,
you need to select it. To select an organism, move the mouse pointer over the
symbol that represents the organism and click the mouse button once. Unselected
organisms look like this: , , ; selected organisms look like this: , , .
To select a second organism, you have to press the shift key on the keyboard while
you click on the second organism. The second organism need not be from the same
vial as the first. If you click on a third organism while still pressing the shift key, the
first organism you selected will be unselected.
Organisms that have participated in one or more crosses appear slightly dimmed. In
some problems, where an organism is only permitted to mate once, these organisms
may not participate in a cross.

Doing Crosses
Genetics Construction Kit allows you to perform several kinds of crosses. Any
particular problem may only support some subset of the available crosses. To find
out what crosses are supported, look at the list under the Cross menu.
Cross Two This is the most general type of cross; it allows you to choose any two
individuals and cross them (provided, of course, that they are of opposite sexes if the
organisms are dioecious).
To cross two organisms, select them both (remember to press the shift key while
selecting the second one), and choose Cross Two from the Cross menu.
There is a shortcut method of crossing two organisms. If you shift double click on
the second organism, the cross will be performed automatically.
Like Cross A like cross is between parents with the same phenotype. To perform a
like cross, select an individual and choose Like from the Cross menu.

Genetics Construction Kit
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If no organism of opposite sex and the same phenotype exists, no cross will be
performed. If more than one such organism exists, one will be chosen at random.
With monoecious organisms, Like will be replaced by Self and will cross an
organism with itself.
Back Cross A back cross is a cross between an organism and its parent of the
opposite sex. To perform a back cross, select an organism and choose Back from the
Cross menu.
Since the parents of organisms in the field population are not known, you cannot
back cross an individual in vial 1.
Reciprocal Cross A reciprocal cross is a cross between parents that have the
opposite combination of sex and phenotype than the parents that produced the
offspring in the selected vial. For example, if a vial has a female parent with Rosy
eyes and a male parent with Carmine eyes, a reciprocal cross would be one between a
female with Carmine eyes and a male with Rosy eyes.
To perform a reciprocal cross, select a vial and choose Reciprocal from the Cross
menu.
Parents used for a reciprocal cross will be taken from the same vials as the selected
vial's parents. If no such parents exist, the cross will not be performed. If there is
more than one possible parent, one will be chosen at random from those available.
Test Cross A test cross is usually defined as a cross with a homozygous recessive
individual. GCK allows you to choose up to two organisms (one of each sex) to be
your test organisms. Once you have chosen test organism(s), you can perform test
crosses by selecting a single organism and choosing Test from the Cross menu.
To choose test organism(s), select the organism(s) and choose Set Test Organism(s)
from the Cross menu. If you only set one test organism you will only be able to do
test crosses with organisms of the opposite sex.
GCK will not verify that the organisms you choose as test organisms are really
homozygous recessive organisms. This is your responsibility.
To see the current set of test organisms, select the Show Test Organism(s) option
from the Cross menu (see Figure 20). The number in front of the organism symbol
is the number of the vial containing the test organism. To identify the particular
organism, click on the sex symbol and it will be selected everywhere it occurs,
including in its original vial.
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Figure 20. The current set of test organisms.

Analyzing and Organizing Your Data
Abbreviating Names
In order to display more information in the same space you may abbreviate the
names of traits and variations. To do this, choose Abbreviate Names from the
Utilities menu. To reverse the abbreviation, choose Abbreviate Names a second
time.
Vial Summary Chart
To summarize the contents of a vial or set of vials, select the set of vials you want to
summarize (remember to hold down the shift key if you want to select more than
one), and choose Summary Chart from the Analysis menu. A window similar to
that shown in Figure 21 will open.

Figure 21. A vial Summary Chart for vials 2 and 3.

The control panel to the left of the Summary Chart controls which traits are
summarized. To change the summary, click in the boxes to toggle the traits on and
off and then click the Rebuild button. At least one trait must be marked at all times.
Turn on a trait before turning off the old one if you are looking at only a single trait.
The population box on top of the Summary Chart lists the vials that have been
clumped together for this summary.
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You can change the order of the phenotypes in the Summary Chart by dragging the
variation names up or down. Large Summary Charts have a grow box and a vertical
scroll bar so that they can be resized and scrolled.
There are three ways you can copy the information in a Summary Chart to store it
in a notepad or to export it to another program. When a Summary Chart is the
frontmost window, the Copy Window, Copy Window Data, and Copy Window Graph
options on the Edit menu will be active.
Copy Window will put an exact replica of the entire Summary Window on the
clipboard.
Copy Window Data will put a textual version of the data on the clipboard that can be
easily exported to a word processor, spreadsheet, or data analysis program. Figure 22
shows the textual form of the Summary Chart in Figure 21.
Population: Vial 2, Vial 3
Phenotype Number
Aristaless 47
Aristopedia 27
Total
74
Figure 22. The textual form of a vial summary created by Copy Window Data.

Copy Window Graph will put a picture of the Summary Chart proper on the
clipboard. From the clipboard it can be pasted into a notepad, a word processing
program, or a painting program.

Figure 23. The picture created by Copy Window Graph from a vial summary.

Chi Squared Analysis
The chi squared worksheet allows you to test how closely an observed ratio matches
the ratios you expect under a given hypothesis. A chi squared worksheet may be
configured to refer to any subset of the possible traits.
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Figure 24. A chi squared worksheet. The hypothesis tested predicts a ratio of 2:1 for Aristaless and
Aristopedia. The p value is .5650.

The control panel is the left-hand part of the chi squared worksheet. It consists of a
check box for every trait in the problem, a check box for sex, if appropriate, and
Rebuild and Calculate buttons. You select the subset of traits you want in the chi
squared worksheet by clicking in the check boxes and click on the Rebuild button to
redraw the worksheet. Click on the Calculate button when you have changed the
expected ratio to recalculate the chi squared values. Pressing the Return key is
equivalent to clicking on the Calculate button.
You cannot specify an empty chi squared worksheet (one with no traits). If you try
to uncheck the last checked trait, nothing will happen.
If you believe that one or more classes of phenotype are missing, enter the
component of the ratio represented by them in the row marked Other. The Other
row is not used unless the expected ratio is non-zero.
Any category can be removed from the analysis by setting its expected ratio to zero.
The p value (lower right-hand corner) is the probability of obtaining, by chance, a
ratio at least as deviant from the predicted ratio as the one observed, if the
hypothesis that made the prediction is valid. Therefore, a high p value is consistent
with your hypothesis, whereas a low p is evidence against it. By convention,
geneticists usually reject hypotheses with p values less than 0.05. However, this
means that they will reject a correct hypothesis 5% of the time.
If there are more than four rows of phenotypes, there will be a scroll bar and a grow
box so that you can make the chi squared analysis window smaller and still access all
the phenotypes.
You can reorder the phenotype rows by dragging the phenotype names up and
down.
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The names of traits and phenotypes can be abbreviated by choosing the Abbreviate
Names option from the Utilities menu.
, may appear on your chi squared
In some circumstances, a caution symbol,
worksheet. If this occurs, click on it for a warning message about the statistical
validity of the particular test you have made.
To perform a test:
•

Select the vial or vials that contain the population of interest.

•

Choose Chi Squared Test from the Analysis menu.

•

Click in the check boxes to set the traits you need.

•

Click the Rebuild button to set up these traits.

•

Enter the phenotype ratios you expect in the first column.

•

Press Return, or click on the Calculate button to recalculate.

The Cross Matrix
The cross matrix is a record of the crosses you have made so far; it is also an index of
the vials generated by these crosses. As a record, you can use it to think about the
kinds of crosses you have made and the kinds of crosses that you need to make in
the future. As an index, it is a useful way to find that pesky little vial you shrank to
an icon a while ago but can't find anymore.
A Record of Crosses
To open the cross matrix, choose Cross Matrix from the Data Analysis menu. You
don't need to select anything first (there is only one cross matrix). Figure 25 is a
cross matrix from a problem with two traits.
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Figure 25 A cross matrix for a two-trait problem. It is set up to look only at the Eye Color trait.

The cross matrix in Figure 25 tells us that we have crossed a Ruby male and a
female Garnet and that vial 3 contains the result of this cross. Similarly, vial 4
contains a Purple x Garnet cross and vial 2 contains a Purple x Ruby cross. The
blank positions in the matrix make clear which crosses have not been made.
An Index into Vials
To retrieve a vial shown in a cross matrix, double click on the vial number. The
vial will be enlarged if it is in icon form, brought to the front, and selected.
The vial shown in the cross matrix is the vial produced by the latest cross of the
indicated phenotypes. If you hold down the option key while double clicking on a
cross matrix cell, all vials produced by the corresponding cross will be brought
forward and selected.

Taking Notes
Using Notepads
Every vial has an associated notepad; to open it, click on the notepad icon ( or )
in the upper right corner. The notepad stays in existence as long as you do not
destroy its associated vial. You can close it temporarily by clicking in its close box,
and when you re-open it, any notes you typed will still be there.
A blank notepad icon indicates that the corresponding notepad is currently empty.
Use the notepad just as you would any other Macintosh word processor. You can
type into it, paste pictures into it, select parts of it to cut or copy into the clipboard,
and print it.
If you are not familiar with standard Macintosh word processing methods you
should consult your Macintosh Owner's Guide for a description.
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Printing Notepads
To print a notepad, make sure that it is the frontmost window (clicking somewhere
in the window will make it frontmost). The frontmost window is the only window
which has a set of parallel horizontal lines around its title. Then choose Print
Notepad from the Edit menu.
For more information on notepad use, see the section on Communicating with
Other Programs.

Cleaning up the Benchtop
After you have been working for a while, your lab bench (the computer screen) is
likely to get quite messy. The Clean up option on the Utilities menu will
straighten things up by putting things in their original places and closing certain
windows.

Changing the Clean up Process
The standard Clean up process places vials and other windows on your screen in a
way appropriate for the standard Macintosh 9-inch screen. If you have a larger
screen or if you do not like the way Clean up works, you can change it. To do this,
choose the Clean up Options option on the Utilities menu. The window shown in
Figure 26 will open.
The check boxes at the bottom of the window allow you to specify which windows
should be automatically closed or (for vials) collapsed to icon form during a Clean
up operation.
The box in the upper part of the window shows where each of the different kinds of
windows created by GCK will be placed when it is first created and when you ask for
a clean up. In Figure 26, the six black rectangles represent the placement of the first
six vials (later vials will be placed on top of the first six, offset a little). You can
change the number of rows and columns of vials, and the spacing between them, by
adjusting the large rectangle with the little grow box in the lower right corner. You
can change the placement of the group of all vials by dragging the big rectangle
around the screen.
To change the placement of other kinds of windows, click on the Next button to
bring the next set of windows to the top, or click directly on the gray boxes
representing the window you want to change.
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Figure 26. The Clean up Options Window.

Communicating with Other Programs
All communication between GCK and other programs takes place via the Macintosh
clipboard. Think of the clipboard as a place you can temporarily store a piece of text
or a picture from one program, and then retrieve it from another program. You
proceed by Copying material from one program into the clipboard, switching to the
other program, and then Pasting the clipboard into the second program.
This can be quite clumsy if you need to move several different things between the
same two programs, since the clipboard can only hold one thing at a time. In this
situation you may want to look into using the Macintosh scrapbook (see your
Macintosh Owner's Guide) which can hold more than one thing at a time.
Cut, Copy, Paste, and Clear
You can use Cut, Copy, and Paste to move text and pictures between GCK notepads
and other programs. Unfortunately, however, it is not possible to copy and paste
mixed text and pictures at one time.
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To copy a notepad that contains both text and pictures you need to do the following:
•

Select the entire content of the notepad. You can do this by clicking
before the first word and dragging to the end, or by clicking once before
the first word, scrolling to the end, and shift-clicking after the last
character.

•

Choose Copy from the Edit menu.

•

Paste the result into an external word processor. Where pictures exist
in the original notepad you will see a little box ( ).

•

For each picture in the notepad:
•
Select the picture. It is critical that you select only the picture
and no surrounding blank space.
•
Choose Copy to put a copy of the picture on the clipboard.
•
Paste the picture into your word processor.

Copy Window
The Copy Window option on the Edit menu is active as long as there is at least one
window open. It will put a picture of the current frontmost window on the
clipboard. Once it is on the clipboard it can be pasted into a notepad or into another
Macintosh program.
The picture of the window looks exactly like the window. This is potentially
confusing because it is not a window any more, but just a picture of one. This
means that the close box and other controls will not work.
Copy Window Data
The Copy Window Data option on the Edit menu will put a copy of the data a
window contains on the clipboard in a form that is usable (not only displayable) by
other programs. The data is in tab delimited text format that is usable by many
word processors, spreadsheets, data base managers, and graphing programs.
Tab delimited text is text arranged in columns with each column separated by a tab.
If you paste this into a word processor you will need to set the tab stops to line up
the columns.
Vials, Summary Charts, and Chi Square Worksheets are the GCK windows that
export their data in this way. The data stored in the frontmost window will be
exported.
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Copy Window Graph
The Copy Window Graph option on the Edit menu will put a copy of the graph in a
Summary Chart on the clipboard. This option is only available if the frontmost
window is a Summary Chart Window.
Printing a Window
You can always print the frontmost window, if you have a printer attached to your
computer, by holding down three keys simultaneously. The three keys are the shift
key, the command key (), and the "4" key. If you also press the caps lock key, the
entire computer screen will be printed. These procedures not only are part of GCK ,
but are characteristic of every Macintosh program.

Getting Help
There are several ways to ask for help from GCK or any other BioQUEST program.
Why Can't I Use This Menu Item?
At any one time several menu items will be gray, indicating that they are inactive
and therefore cannot be used. Active menu items appear in black. It is not always
obvious why a menu item is inactive, or how to make it active. In GCK, if you try to
choose an inactive menu item, you will get a short message explaining what to do
in order to enable it (see Figure 27). Usually this means selecting an object.

Figure 27. A Help message explaining why the Vial Summary item is inactive.

Use the scroll bar on the right to see text that is not immediately visible. When you
have finished reading the help message, you can dismiss it by clicking in the
window close box.
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What Is This Thing For?
To find out what something is or does, you need to be in Help mode. To enter help
mode, press the command key () while simultaneously pressing the question
mark (?) key. On some keyboards there is a key labeled help. If your keyboard has a
help key, it will do the same thing.
When you are in Help mode, the mouse cursor will look like this , instead of the
usual arrow shape. In help mode, all menu items are always active. Selecting a
menu item will give you a short description of what the menu item does (see Figure
28).

Figure 28. An explanation of the Vial: Summarize menu item.

Besides menus, you can click on just about anything and get some information
about it.
Usually, you automatically drop out of Help mode after you get help once.
Sometimes you want to ask for help on several things and it is useful to stay in Help
mode. If you hold down the option key while clicking, you will stay in Help mode.
What about the Big Picture?
The general help system is accessible from the Help With GCK option under the
Apple () menu. If you choose this option you will be given a list of topics from
which to choose the subject of interest (see Figure 29). To open a topic, click on it
and click the Open button at the bottom of the Help Window, or double click on the
topic line. When you open a topic you will see either a list of subtopics or a
discussion of the subject.
At the bottom there will often be a Back button. Pressing it will return you to the
topic list that led you to the current window. Sometimes there will be other buttons
that should be labeled so as to be self-explanatory.
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Figure 29. The Help with GCK topic list. Clicking Open will lead to information about Quick
Tutorials.

Saving and Opening a Problem
Saving a Problem
You can save the state of the problem you are working on at any point by choosing
the Save option from the File menu. This saves everything so that you can later
come back to the problem in the same state it was in when you left it.
There are a number of reasons you may want to save a problem. The simplest is
that you may want to take a break and come back to a problem later. Another reason
is to keep all of your original research data. If someone then challenges your
conclusions, you can go back to the original organisms with new questions. Or you
may want to save a copy of a problem before you do any work at all so that another
research team can work on exactly the same problem and you can pool, and argue
over, your results.
You may also want to save against the possibility of catastrophe in the form of a
power failure or a problem with the program that causes it to stop working
suddenly.
When you choose Save the first time, you will be asked to give the problem a name
(see Figure 30). If the process of giving a file a name is unfamiliar to you, please
refer to BioQUEST: Macintosh Basics.
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Figure 30. A Save Problem dialog box. By default, the problem will be saved under the name
“Untitled0.”

When you are ready, click the Save button to save the problem, or click the Cancel
button if you decide not to save.
The second time you choose Save, your problem will automatically be re-saved
under the same name you used the first time.
If you want two different copies, use the Save As option instead of Save. This will
ask you for another name.

Opening a Saved Problem
There are two ways to open a previously saved problem. The simplest way is to
double click on the saved problem's icon from the Finder (see Figure 31).

Figure 31. A saved problem icon.

Alternatively, if you are already running GCK, you can choose Open from the File
menu and choose your problem from the list presented there.
Note that you can only have one problem open at a time. If you try to open a second
problem, you will first be asked if you want to save the current problem.
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Designing Your Own Problems
In order to create or edit GCK problems you must have access to an editable copy of
GCK. A copy of GCK is editable if the initial screen that appears when you start the
program has a set of buttons where the picture of a fruit fly is normally displayed.
Figure 32 shows the startup screen of an editable copy of GCK. Many copies of GCK
have this capability disabled.

Figure 32. Startup screen for an editable copy of GCK. Note that the fly picture that normally appears
to the left has been replaced by four buttons.

Click on the New Problem button to create a new problem.
Select a problem and then click on Delete Problem to destroy that problem.
Click on the Remove button to lock this copy of GCK so that it will no longer be
editable. This is not reversible, so make sure that you have another editable copy of
GCK before you use this.
To change an existing problem, click on the problem name and then click on the
Edit Problem button. Once you have selected a problem to work on, you will be
given an opportunity to change the problem type's name, to change the organism
parameters, to change the genetic parameters, or to modify the problem menus (see
Figure 33).
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Figure 33. Change problem type name and select parameters to change.

You can edit the problem type name with the normal Macintosh text editing
techniques. To edit one of the parameter sets, click on the appropriate button.
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Organism Parameters

Figure 34. Organism Parameter editing.

The two editable fields on the first line specify the number of organisms that will
appear in the field vial. In this case at least 25 and no more that 50 organisms will
appear in the field vial.
The second line puts limits on the number of progeny resulting from a cross.
The fourth line specifies how many traits will be reported in problems of this type.
For monohybrid problems, use 1; for dihybrid problems use 2, etc.
The fifth line specifies whether the organism is dioecious or monoecious.
Dioecious organisms are displayed as and and must be crossed with individuals
of the opposite sex. Monoecious organisms are displayed as ( ) and may be crossed
with themselves or any other organism.
The last line governs whether an organism can mate only once or an unlimited
number of times.
Click Cancel to discard the changes you have made to this problem, or OK to keep
them.
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Genetic Parameters

Figure 35 Genetic Parameter editing.

Figure 35 shows the genetic phenomena that may occur in a GCK problem and
allows you to put broad limits on the kinds of problems that GCK will generate. For
the moment, at least, you cannot specify exactly what problem you want GCK to use.
We plan to provide the tools to build exact problems in the future but we feel that
this imprecision can be good. It makes it easy to build problems that are
unpredictable, so that the builder of a problem set can easily be a colleague in the
problem solving process, not an omniscient leader.
Each of the possible genetic phenomena may be turned on or off by clicking in the
appropriate check box. If there is no check mark in the box, that phenomenon will
not occur in problems of this type. If there is a check mark, the phenomenon may
occur, depending on the other settings.
Codominance
If you want all traits to follow a simple dominance pattern of inheritance make sure
there is no check in the Codominance check box. If you want some traits to exhibit
the codominance pattern, put a check in the check box and enter the probability of
codominance in the appropriate box. A probability of 100 means that all traits will
be codominant. A probability of 50 means that, on the average, 50% of the traits in a
problem will be codominant.
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Sex Linkage
If you turn on sex linkage you can control the number of traits that will be sex
linked by setting a minimum and a maximum number of sex-linked traits.
In the example above, every problem will have one sex-linked trait.
Multiple Alleles
The multiple alleles probability is the chance that a problem trait will exhibit the
multiple alleles inheritance pattern. If it is 100, all traits in all problems of this type
will have multiple alleles; if it is 50, a trait will have more than two alleles 50% of
the time.
You can control the number of alleles that will be used by specifying a minimum
and a maximum. You can control the number of variations a trait will exhibit by
setting MinVariations and MaxVariations. The number of alleles in a trait puts
limits on the possible number of variations so you should click on the Check button
to make sure that the number of variations required is possible. This will also check
that the number of alleles asked for is within the limits allowed by the program.
In the example shown in Figure 35, every trait in a problem of this type has a 30%
chance of having more than two alleles. Of this 30%, half will have three alleles
and half will have four alleles. One-third will have four variations, one-third will
have five variations, and one-third will have six variations. Note that the multiple
alleles settings override the codominance settings in order to comply with the
requested number of variations.
Autosomal Linkage
If linkage is turned off, all loci will independently assort. If it is turned on, loci will
be linked with the indicated range of map distances. The Probability of
Chromosome Switch is the probability that two loci will be separated not by a
distance in the indicated range, but by a map distance of 50%, equivalent to being on
a different chromosome.
In the example shown in Figure 35, 95% of the time loci will be separated by a
distance in the range 5 to 15 map units; 5% of the time they will be separated by 50
map units. The distance between loci is set once when a problem is generated and is
not changed thereafter.
Checking the Parameters
Once you have set up the problem type you want, click on the Check button so that
GCK can check to make sure that it can create the problem that you asked for. If
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something you asked for is impossible, it will be changed to something possible
when you click on the Check button. For example: This version of GCK has a limit
on the number of alleles at a locus. To find out what it is, try setting the maximum
number of alleles to 50, and press Check. GCK will reset the number to the largest
number of alleles it can handle.
Menu Parameters

Figure 36. Menu Editing.

The menu parameter editing dialog (see Figure 36) allows you to decide what menu
options you feel should be available for your problems. To toggle an entire menu
on and off, click on the check box with the menu name. To toggle a menu option
on and off, click on the corresponding check box. A menu or menu option without
a check mark will not be visible when the problem is used.
Some typical uses of this facility are:
1) To prepare the simplest possible version of GCK: Disable all the options on
the Cross menu except for Cross Two. Disable the entire Analysis menu (except
perhaps for Summary Chart). Disable the entire Utilities menu.
2) It is fairly common to disable the three Test Cross items on the Cross
menu because their usage is unusual in simpler problems.
3) Some people feel that experimental data should never be destroyed and
therefore like to disable the Destroy Vial(s) option.
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Trait and Variation Names
For the moment, in order to change the names of GCK traits and variations you
need to be familiar with the ResEdit tool available from Apple Computer. Use
ResEdit to open GCK and edit the resources of type TNAM.
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How GCK Works
When GCK starts a new problem it first has to read the problem parameters and use
them to build a set of genetic rules that we will call the “species model.” Once it has
a species model, it uses the model to create a field population of organisms and
consults the model when it needs to cross two organisms.
This description attempts to provide an accurate overview of the internal model of
genetics used by GCK. It is simplified so that the details don't obscure the overview
and will certainly change as new genetic phenomena are added to GCK.

The Species Model
The GCK species model has three basic parts: a locus table, a genotype to phenotype
map, and an initial allele frequency table.
Locus Table
The locus table has one entry for each locus (at the moment there is one locus for
each trait; this will change when we add pleiotropy and gene interaction). Each
locus entry has three pieces of information: the number of alleles at the locus, the
map distance from this locus to the next locus, and a flag indicating whether or not
this locus is sex linked. Sex-linked loci are restricted to being contiguous and to start
at the beginning of the table. This prevents having sex-linked loci separated by nonsex-linked loci.

Figure 37. An example of a three-locus locus table.

Figure 37 is an example of a locus table. This locus table describes a problem with
three loci. The loci are listed in fixed chromosomal order. The first locus has two
alleles and is sex linked. The second locus has three alleles, is not sex linked, and is
separated from the first locus by 12 map units. The third locus has two alleles, is not
sex linked, and is separated from the second locus by 50 map units (it could be on a
separate chromosome or far away on the same chromosome; without intervening
loci it is impossible to tell).
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Genotype to Phenotype Map
The genotype to phenotype map has an entry for every possible combination of
alleles at each locus.

Figure 38. An example genotype to phenotype map.

Figure 38 shows an example genotype to phenotype map that is compatible with the
example locus table in Figure 37. Alleles are encoded as numbers; each pair of
numbers is a genotype. This map specifies that locus A controls the Eye Color trait
and is codominant. The two homozygous phenotypes are Rosy and Sepia and the
heterozygous phenotype is White. Locus B controls Wing Shape; there are four
variations, and all have a dominant relationship except for alleles 2 and 3 which are
codominant. Locus C controls the Abdomen trait in a simple dominant
relationship.
Allele Frequency Table
The allele frequency table is just a table of allele frequencies for each locus (see
Figure 39).

Figure 39. An example allele frequency table.

This table specifies the allele frequencies that will be used to create the field
population. We adopted this approach to combat the common student assumption
that the most frequent is automatically the dominant phenotype.
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The Field Population
After GCK has built the species model described above, it creates the field
population. First, it decides how many organisms to put in the field population by
picking a number between the minimum and maximum specified by the problem
type creator (in the organismal parameters). Second, for each of those organisms it
creates a chromosome. Each of the field organisms is assigned a sex at random (i.e.,
male with 50% probability, female with 50% probability). Then the organism is
assigned a pair of alleles at each locus according to the frequencies declared in the
allele frequency table (see Figure 39). For example, at locus A each organism has a
30% probability that its first allele will be a 1 and a 70% probability that its first allele
will be a 2. The same probabilities apply to the second allele.

Female

2, 2

1, 3

1,1

Figure 40. An example organism chromosome.

Figure 40 is an example organism chromosome. Once the field population
genotypes have been generated via the procedure described above, their phenotypes
are found by looking them up in the genotype to phenotype map. According to the
map in Figure 38, this example organism would have Sepia Eyes, Dumpy Wings,
and a Fat Abdomen.
Notice that we simulate any number of chromosomes with just a single internal
chromosome. To simulate more than one chromosome we specify a recombination
frequency of 50% between two of the loci. They will then act just as if they were on
separate chromosomes.
By convention, we consider the first allele in each allele pair to be on the maternal
chromosome and the second to be on the paternal chromosome.

Crossing
GCK crosses two organisms by simulating the meiotic process that occurs in real
organisms. First it creates a maternal haploid chromosome by simulating crossing
over between the two original maternal chromosomes. It creates a paternal haploid
in the same way. These two haploid chromosomes are then combined to create the
diploid chromosome used in the final progeny individual, i.e., identical to
fertilization, the fusion of haploid gametes to form a zygote. This process is repeated
with the same two original diploid chromosomes until enough progeny have been
generated. Note that this procedure is a departure from Drosophila genetics since
there is usually no crossing over in Drosophila males.
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The generation of a haploid chromosome from a diploid is accomplished with the
help of the locus table shown in Figure 37. First, one of the two strands in the
diploid is chosen at random, this allele is copied into the haploid chromosome, then
with a probability set by the distance in map units to the next locus, we either cross
over to the other diploid strand or we continue with the current strand. This
continues until there are no more loci.
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Glossary
Active Menu

An active menu appears as black on white. This is a sign that
at least one of the items on the menu is active. An active
menu item is one that you are currently allowed to choose.
Inactive menu items, which appear in gray, are not allowed at
the moment. To find out why an inactive menu item is
inactive, try to choose it. You will get a short explanation of
how to activate it.

Active Window

The active window, also called the frontmost window, is the
window with the horizontal lines around the title. There
should only be one active window. See also: Selected Window.

Allele

One of several mutational forms of a gene.

Check Box

A standard way to turn something on or off. An 'X' in the box
means it is turned on; no 'X' means it is turned off. Click in
the box to toggle between the two states. ex.

Chi Squared Test

For a general description of the chi squared statistic, see your
text book or a statistics text. The limited version of the chi
squared text available in GCK is a measure of the similarity of
two distributions. Usually you will use it to compare the
results you expected from a cross with the results you actually
got.

Clipboard

The clipboard is an invisible place where something (usually a
picture or a few words) can be stored for a moment. When you
Copy text you put it on the clipboard. When you Paste you
are pulling something off the clipboard to insert into a
document. The clipboard is part of the computer, not part of
the particular program you are using, so you can use it to
transfer information from one program to another.

Cross

A cross is a mating between two organisms that results in a set
of offspring. In GCK, these offspring will appear in a newly
created vial window.
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Customize

The ability to change parts of the program to better fit your
needs and instructional objectives. In GCK you can change the
set of operations available on the menu bar, the range of
genetic phenomena that occur in a problem, and the names of
the traits and variations used by the program.

Dialog Box

A window that contains requests for instructions or
information. For instructions on using dialog boxes see your
Macintosh Owner's Guide.

Dioecious

For GCK, having two sexes. The botanical definition is more
specific.

Field Population

The population of the first vial to appear on the screen. This
population was collected from the field and is not the result of
a cross, so its phenotypic ratios are not significant.

GCK

Genetics Construction Kit (this program).

Genotype

The internal genetic constitution of an organism. See
Phenotype.

Heterogametic

An organism with two different sex chromosomes or only a
single sex chromosome. Human males and fruit fly males are
both heterogametic while the corresponding females are
homogametic.

Homogametic

An organism with two copies of the same sex chromosomes.
Human females, with two X chromosomes, are homogametic
but human males, with an X and a Y chromosome are
heterogametic.

Locus

The position of a gene on a chromosome. Any one of several
alleles of a gene exists at that gene's locus.

Mendelian
Genetics

The core body of genetic phenomena stemming directly from
Gregor Mendel's three principles of heredity. For the most
part, this is the set of genetic phenomena available in GCK. An
exception is autosomal linkage, which breaks Mendel's law of
independent assortment.

Menu

At the very top of your Macintosh computer screen there is a
white bar with a number of symbols and words. This is called
the menu bar, and each of the symbols and words is the title of
a menu. For more information about menus and how to use
them, see your Macintosh Owner's Guide.
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Monoecious

Hermaphroditic. Individuals may mate with themselves;
there are not two separate sexes.

Mouse

Please see your Macintosh Owner's Guide for information
about what a mouse is and how you use it.

Notepad

A notepad is a window that you can type into, or insert pictures
into. It is a place to write notes to yourself, or to collect your
thoughts for a lab report. Each vial has an associated notepad.
symbol in the upper left of the vial.
To open it, click on the

Object

When we use the word object in this manual, we mean
something that can be selected. Organisms, represented by the
small sex symbols, and vials, represented by vial windows, are
the objects in GCK.

Phenotype

The observable properties of an organism. A result of the
collective action of its genotype and its environment.

Progeny

Offspring, the children that result from a mating.

Scrapbook

The scrapbook is a desk accessory that will store more than one
thing for you. This is an advantage over the clipboard which
can only store one thing at a time. See your Macintosh
Owner's Guide for more information on desk accessories and
the scrapbook.

Selected
Organism(s)

One or two organisms identified for use in the next cross or
other event. Selected organisms appear as white on black.

Selected Vial(s)

One or more vials identified for use in the next operation. The
titles of selected vials appear as white on black.

Trait

A characteristic of an organism that is being considered
genetically. Eye color, eye shape, and finger length are traits.
Each trait has one or more variations. The eye color trait might,
for example, have the variations red, blue, and green.

Vial

In this program, the windows that display a set of organisms
are called vials. They are called vials because one of the
standard organisms used in genetic research, the fruit fly, is
generally kept in small glass jars called vials.
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Variation

The different forms of a trait. The trait number of fingers, for
example, might have three possible variations: four, five, and
six.

Window

A window is an area of the computer screen, usually
rectangular, that displays information. Most windows have a
title displayed at the top. For more information see your
Macintosh Owner's Guide. Vials, Notepads, Summary Charts,
etc. are all examples of windows.
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Appendices:
It Doesn't Work!
The program won't run.
Have you booted your system properly?
If this question doesn't mean anything to you please consult the manuals that came
with your Macintosh, or ask someone who has used a Macintosh computer before.
Are you using System 6.0 or later?
GCK requires System software 6.0 or later to run properly. To check which version
of the system software you are using, choose About the Finder option under the 
menu.
Are you using a Macintosh Plus or later computer?
GCK will not run on a Macintosh 128 or Macintosh 512.
Maybe it's a bug?
If you answered yes to all of the preceding questions maybe you have discovered a
problem in GCK . Please report the problem and circumstances back to the program
authors.
The program doesn't look like the picture in the manual.
Maybe it is not supposed to look like the picture in the manual.
GCK can be modified to look quite different from what we have shown in the
manual. Read the section at the beginning of this document A Word of Warning to
see if the difference might be something like this. Also, ask the person you got the
program from if they have changed something. If so, they ought to be able to tell
you what differences to expect.
Maybe you have the wrong manual.
GCK is not in its final form so it changes periodically. While we try to keep the
manual up to date it does tend to lag a little behind the program. It is also possible
for the wrong version of the manual to accidentally be included with a program.
The current version of the program when the manual was last updated is printed at
the bottom of every page. You can find the current version of the program by
running GCK and choosing the About GCK option from the  menu. If the two
version numbers do not match then this might be your problem. You should also
be able to find a document called GCK Version History. This might be able to tell
you something about the differences between your copy of the program and your
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copy of the manual. Otherwise, contact the person you got the program from and
ask what has changed.
Maybe it's a bug.
If the problem is not covered under the preceding topics you may have discovered a
problem in the manual or in the software. In either case, we would like to know
about it. Please convey the circumstances and problem back to us.

Hardware and Software Requirements
GCK requires a Mac Plus or later Macintosh computer running System 6.0 or later.
To tell what system you are running, choose the About the Finder item from the 
menu of the Finder program. The Finder program is where you start out, before
you run a program like GCK.
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Abbreviate, 22
Allele Frequency, 42
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Clean up, 27
Clear, 28
Clipboard, 28, 45
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Create Problem, 34
Cross, 45
Back, 21
Find, 26
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Reciprocal, 21
Record, 25
Self, 20
Simulation, 43
Test, 21
Cross Matrix, 25
Customize, 46
Cut, 28

Data, 29
Database, 29
Design Problem, 34
Dialog Box, 46
Dihybrid, 36
Dimmed
Organism, 20
Dioecious, 36
Edit Problem, 34
Export Data, 29
Field Population, 7, 43, 46
Finding
Cross, 26
Vial, 26
Frontmost Window, 27, 29, 30, 45
Genetic Parameters, 37
Genotype, 46
Genotype to Phenotype Map, 42
Graphing Program, 29
Help, 30
Help Mode, 31
Heterogametic, 46
Homogametic, 46
Icon
Vial, 15
Layout, 27
Linkage
Autosomal, 38
Sex, 38
Locus Table, 41
Macintosh, 2
Make Problem, 34
Map Distance, 38
Memory, 20
Menu
Active, 45
Gray, 9, 30
Help, 9, 31
Parameters, 39
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Mess, 27
Model
Species, 41
Monoecious, 36
Monohybrid, 36
Multiple Alleles, 38
Notepad, 19, 26, 47
Printing, 27
Open Problem, 33
Option Key, 26, 31
Organism
Dimmed, 20
Dioecious, 36
Monoecious, 21, 36
Parameters, 36
Select, 20
Symbol, 21
Organisms
Select, 10
p value, 24
Paint Program, 23
Pane Control
Vial, 17
Parameters
Checking, 38
Genetic, 37
Menu, 39
Organism, 36
Parents, 11, 19
Paste, 28
Phenotype, 47
Phenotypes
Order, 18
Printing
Notepad, 27
Windows, 30
Problem
Create, 34
Edit, 34
Name, 35
Open, 33
Save, 32
Progeny, 36, 47
Question Mark, 31
Quit, 13
Ratio, 23

Rebuild, 12, 22, 24, 26
Record
of crosses, 25
Resize
Vial, 15
Restore Problem, 33
Save Problem, 32
Scrapbook, 28, 47
Scroll Bar
Active and Inactive, 16
Scroll Box, 17
Scrolling
Vial, 16
Select
Organisms, 10
Vial, 14
Select Organism, 20
Setup
Problem, 34
Shift Click, 10, 20
Shift Key, 30
Simple Dominance, 37
Simulation
Parameters, 34
Spreadsheet, 23, 29
Statistical Validity, 25
Summarize
Vial, 12, 22
Symbol
Dimmed, 20
Organism, 21
Tab, 29
Traits
Number of, 36
Order, 18
Vial
Close, 15
Control, 14
Destroy, 19
Field, 36
Finding, 26
Icon, 15
Index, 26
Notepad, 19
Pane Control, 17
Phenotype Order, 18
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Scrolling, 16
Select, 14
Size and Shape, 15
Summarize, 22
Trait Order, 18

Vial Notepad, 26
Window
Printing, 30
Word Processor, 23, 26, 28, 29
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